GSAK (Geocaching Swiss Army Knife)

GSAK

GEOCACHING SOFTWARE ADVANCED KLASS
GSAK - 102
by
C3GPS & Major134



Table of Contents

About this DOCUMENT.....cciiiiiiiiiiiii s s s s iii

Class Materials ......uuuuueuii e iv

0 oo o 4Tt 1

IO Yo [o [ 1Y -3 e Yot 1 4 o] o - PR PRTPPPRN 1

Objective 1.1a: Add your home coordinates as a location........ccceeeeecciiiieeee e 1

Objective 1.1b: Add the coordinates of a cache as a location .........ccceecuvveeeecieieicciee e 1

07 o Vo [T Y= Mo Yot 1 oY o -SSR PRPRNt 2

Objective 1.2a: Hide the BeeHave! 10Cation.........ccuveiiiiiii it 2

1.3 Setting a Default Location for @ Database ........ccccveiiieciiii it 2

Objective 1.3a: Set the default location to BeeHave! ..........ccoveeeeiiioiiiiieeieeeeeeee e 2

R T oY i = Mo ToF= | To 3SR 3

Objective 1.4a: Delete BeeHave! from the list of [0cations .........cccceeieciiieicciiee e 3

2.0 Adding to BOOKMArK LIStS .....cccceuuiiiiieeiiiieiicerieiaceeeeianeeseennsessennssessennssessensssssesnsssssssnsssssssnsssssenns 4

Objective 2.0a: Create a bookmark list and add caches to it from GSAK..........cccovvveeeeieeicnnnne 4

3.0 POlYZON/LIiNE DraWing TOO ... ccccittireeuurieieriierenenenreeeteeeeesssssssssesseesasssssssssessssssssnssssssessssssssnnsnsnnes 5
Objective 3.0a: Filter for caches in New Mexico and Arizona using the Polygon/Line Drawing

Lo ] PR OO PO PPOPRRPRRR 5

4.0 GSAK IZNOKE LiSt.....cicuuiiieiiiiiiieeiiiiniiieeieieasirtnistnsierenserensersnssssnssssnsssssnsssssssssnssssnsessnssssnssssnnsssnnns 7

4.1 Adding Caches to the IN0Ie LiSt ......ccuieiiieiiiiiiciee e rae e e s rbae e e e 7

Objective 4.1a: Add Old Griz to the ignore list........ccoieciieiieciiec e 7

4.2 Deleting Caches from Your IZNOre List ......c.ceiiiiiiiiiiiiiie ettt e e e 8

Objective 45.2a: Remove Old Griz from the GSAK Ignore List ........cccceecvieeieciieeeeciiee e 8

L T T 9

Objective 5.0a: Create a View with the Found by Me column not visible ...........cccccceeeiiennnns 9

Objective 5.0b: Assign the view to be used every time you open the GSAK Class database....9

Objective 5.0c: Delete the Unfound VIEW..........coovuiiiiiiiiiiieccee e 10
6.0 REPAII/DEFIAg ...uuveeererernrirrrsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnsssnsnnes 11
Objective 6.0a: Repair/Defrag the GSAK Class database ........cccceevveevveeeerereeveeeceeeeree e 11
7.0 SHOMECUL K@Y S . cuuiiiiiiiiieiiiiiiieeeteeiiteetteeietnaeteesesensssensessnssssnssssnssessnsssensessnssssnssssnssssensssensasannans 12
Objective 7.0a: Assign F9 as the shortcut key for cancelling a filter .........cccccoeeieeiirennnne.. 12
8.0 QUICK FIlErS ..t 13



S O LY (oY= 1U ] ol S 1 =Y SRS 13

Objective 8.1a: Use quick filters to filter on Traditional caches only........ccccccvveeeciieeeeininenn. 13
Objective 8.1b: Add to our existing filter to include only caches with a bearing of NW ........ 14

8.2 Filtering from the STatus Bar .....cciccuiiiiiiiie ettt e s e e s s sabee e s ssabee e s eareeas 14
Objective 8.2a: Set a filter to show only found caches .........ccccvvveiiiiiiiiiicc e, 15

1= 0T 0114 o T 4 T D = | - RN 16
Objective 9.0a: Add a custom column for the city name where the cache is located ............ 16
Objective 9.0b: Make the City custom field visible in the database grid ..........ccccccvvveeinneennn. 18
Objective 9.0c: Add a value to the City custom field.........coovvvviiiiiiiiiiiie e, 18
Objective 9.0d: Delete the City custom field.........ccveeiriiiiiiiiiiie e 18



About this Document

This document was created for the GSAK 102 Event sponsored by SLAGA (http://coord.info/GC66PD1)
event.

In this class, we will not spend time going over the GSAK 101 or GSAK 201 material. If you need a
refresher in 101 or 201, contact Major134; and, he will send you a digital copy of the syllabus for
either of the classes. There is enough 102 material to cover and we will not have time to cover
subjects from the other classes. It will be assumed that you have GSAK already installed. You MUST
have the latest version of GSAK installed. To make sure you are on the most current version, please go
to Tools>Options, Advanced tab and make sure you have the "Check for patches" box checked. If you
are on the most current version, it will be at least 8.6.1.41. Version 8.6.0.0 is NOT current and many
bugs have been fixed as well as features added since that version was released, some of which may
affect topics covered in this class.

In the class we will first give an explanation of the subject matter and follow it with challenges that a
user may face and offer solutions detailing how to overcome the challenges. Questions during class
are welcome and encouraged.

In this document you will see words or phrases that are in bold text. Those generally will refer to
window titles, labels on windows, etc... Basically something that needs to stand out or be found on the
screen will be bold.

You will also see the following icons that are used to make it easy to find different items in the
document:

@ This icon refers to additional information. It will be used to explain a point that may be
~confusing as you walk through the steps of an objective.

-"i‘* This icon also refers to additional information but is a bit more important. Generally, these are
£ warnings that could be “gotchas” if you are new to the process.

This icon will signify the beginning of an objective.

What you should bring to class:
1. A laptop with the most current version of GSAK already installed.
2. Pen and paper for notes.
3. A flash drive (not required but might be helpful).
4. Questions!



Class Materials

In addition to this syllabus, a gpx file with the database used for this syllabus will be provided.

GSAK201.gpx



1.0 Locations

Locations are used to set the center point for the database. If you have your database set to show the
Distance column (header will either be in Miles or Kilometers depending on your settings) it will
display the distance from the center point shown in the Locations drop down on the toolbar.
Generally, you will want at least one location set from your house. However, if you are travelling you
may want to set a location at the coordinates of your hotel or wherever you will be staying. That way
GSAK will show you the distances from there instead of your home.
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1.1 Adding Locations

Adding locations is very easy. There are at least two ways to do it.

Objective 1.1a: Add your home coordinates as a location

I
1. Click the Tools menu.
2. Click the Options... menu item to open the Options window.
3. Click the Locations tab.
4. On this tab, you will see instructions along with a text box that will allow you to type your

locations. You MUST put the information in the correct order and format. First you type the
name of your location, then a comma, then the coordinates to the location. So, type the
following without the quotes: “Home, N38° 37.802 W90° 24.296”. If you know the actual
coordinates of your home then type those instead.

5. Click the Ok button to save the location.

Now in your Locations dropdown on the toolbar you should see “Home” listed. If you choose it, your
distances will change to show the distance from the coordinates entered for Home.

i Objective 1.1b: Add the coordinates of a cache as a location
Sometimes it may be easier to just add the coordinates of a cache that is near where you are going to
stay. So, rather than look up the coordinates to a hotel and type them into the Locations tab, you can
easily just add the coordinates to a cache into the Locations tab.

1. Open the GSAK201 database.

2. Single click on the BeeHave! cache.

3. Click the Waypoint menu.
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4. Click the Add to Locations menu item. A message box will appear telling you that the
waypoint has been added to Locations.
5. Click the Locations dropdown. You will now see BeeHave! in the list!

1.2 Hiding Locations

Let’s say you do a lot of travelling to the same place often so you add that location (for arguments
sake, let’s say there’s a hotel next to BeeHave! and we go there all the time) to your Locations list.
However, you don’t really want it in your list when you are home. Rather than delete it and have to

add it back again, we can just hide it.

I Objective 1.2a: Hide the BeeHave! location
Click the Tools menu.

Click the Options... menu item to open the Options window.
Click the Locations tab to show the list of locations.

In the list of locations, type # before BeeHave!

Click the OK button.

vk wN e

Now when you check the Locations dropdown on your toolbar, BeeHave! will no longer be there.

1.3 Setting a Default Location for a Database
Each database can have it a default location that will be set when you open that database. So, if you
don’t want to change the location to BeeHave! every time you open the GSAK201 database, you can

set it as the default.

i Objective 1.3a: Set the default location to BeeHave!
In the Locations drop down on the toolbar, choose BeeHave!

Click the Database menu.

Click the Properties... menu item to open the Database properties window.

In the Center point section on the Database properties window, uncheck Use same as last
open of this database and then click the Grab current button. You'll notice that GSAK will fill
the Description and Coordinates boxes with the BeeHave! location information.

5. Click the Apply button to save the changes.

el

Now, every time you leave and come back to the GSAK201 database, the BeeHave! coordinates will be

set as the location by default.
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1.4 Deleting Locations
Well unfortunately our work near BeeHave! has come to an end so now we no longer need it in our
list of locations at all. Let’s go ahead and delete it from the list so it doesn’t clutter up the dropdown

list.

i Objective 1.4a: Delete BeeHave! from the list of locations

Click the Tools menu.

Click the Options... menu item to open the Options window.

Click the Locations tab to show the list of locations.

In the list of locations, highlight and delete the entire line with BeeHave!
Click the OK button.

vk wN e

BeeHave! will no longer be in your list of locations on the Locations tab.
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2.0 Adding to Bookmark Lists

On Geocaching.com you can create bookmark lists which are lists of caches that you want to mark for
future use. Maybe you just want a list of caches that are on your own bucket list or a list of caches that
are at museums. As you find them, you can add them to the list for easy access in the future. GSAK
gives us the ability to add caches to lists that we have created on Geocaching.com.

e

il Objective 2.0a: Create a bookmark list and add caches to it from GSAK

1. Inyour favorite browser, open geocaching.com and log into your account.
2. Onthe dashboard page, down the left side is a section called Lists. Click “Your lists”.

LISTS

Your lists
Watchlist

Favorites

3. Inthe blue banner at the top, click the “back to the old page” link.

Welcome to the new Lists page. If you don't like it, you can gc back to the old page. Let us know what you think

4. On the right side of the screen click the Create New Bookmark List link.

5. Inthe Name box type GSAK Class.

6. Description is not required, but you can enter anything you wish in the Description box.

7. Click the Create Bookmark List button.

8. Now that we have created our list, go back to GSAK and open the GSAK Class database.

9. Click the Geocaching.com access menu.

10. Click the Add to bookmark list... menu item to open the Add to bookmark list window. You
will see a list of all of your bookmark lists that have been created.

11. Choose the GSAK Class bookmark list.

12. To add all of the caches in the current filter (in this case, the entire database of 10 caches)
select the All in current filter option. (If you only wish to add 1 cache, select the cache, open
this window and choose the Current cache only option).

13. Click the Add button.

GSAK will do its thing and add the cache(s) to the chosen bookmark list. If you now go back to
geocaching.com and open the list, you'll see the items we just added.
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geocaching.com

3.0 Polygon/Line Drawing Tool

The Polygon/Line Drawing Tool is a web based tool, accessed through GSAK, that will allow you to
draw a polygon on a map and then filter your database to only show caches within the polygon you
drew.

r"i“ Note that this functionality does not retrieve caches that are not in GSAK and then import

== them. This simply allows you to set a filter with caches already in your GSAK database that
are within the borders that you determine.

i

| realize that there are more efficient ways to filter for caches in specific states. I’'m just using
New Mexico and Arizona as easy examples to show how the tool works.

Objective 3.0a: Filter for caches in New Mexico and Arizona using the

Polygon/Line Drawing Tool.

1. Open your GSAK Class database.
Click the Tools menu.
Click the Polygon/Line Drawing Tool menu item to open the GSAK Google Maps Polygon to
CSV/GPX File Digitizer window in your internet browser.

4. In the top left corner of the map you will see 3 buttons. The hand is to tell the tool to stop
drawing and allow you to drag the map around. The middle button is for drawing lines and the
third is for polygons. | haven’t really ever figured out the difference in functionality of the
second two buttons. They both end with polygons so you can feel free to click either one to
draw our polygon around New Mexico and Arizona. AR <

5. After you click either the Draw a line or Draw a shape button you can begin to draw your
polygon. Start by clicking on one corner. Then just click each spot around the shape you want
until you get back to where you started. When finished you should have a polygon drawn
around both states (roughly) and a list of coordinates on the right side.

COLORADO 37.037640,-114.080053
36.043035,-114.213887
36.237418,-114.63726¢
34.849875,-114.697266

Iea;r 34.138173,-114.257313
5L 33.284620,-114.825102
- 32.953365,-114.35364¢%
I Mbquﬂque 32.620870,-114.741211
2 31.334871,-111.071777
@ ARIZONA NEW MEXICO 31.334871,-108.171387

y Ph?f"” 31.765537,-108.215332
O 31.765537,-106.479492
o Tuceon 31.989442,-106.501465
*ita._ o ~ ElPasa : 31.983442,-102.941855%
~ ® e ! = 37.037640,-102.335240

JA Qo @, \\\\ 37.037640,-114.080059
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If the shape you drew is satisfactory, click the Send to GSAK button. The Set Filter window will
open with the Arc/Poly tab chosen and the list of coordinates already filled in the box.
Click the Go button and the filter will be set to only show caches that are within the polygon

that you drew.
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4.0 GSAK Ignore List

Much like geocaching.com, GSAK has the ability to ignore caches. Once you add a cache to the ignore

list in GSAK, it will not be imported into this database again until you remove it from the ignore list.

f;'i\\ The ignore list on geocaching.com and the ignore list in GSAK are not related to each other. If
== you want to ignore caches in both places, you must tell both individually that you want to

ignore a cache.

e Adding a cache to the ignore list for a database is database specific. It can still be imported into

other databases while on the ignore list for another database.

4.1 Adding Caches to the Ignore List

There is one way to add caches to the ignore list. When you delete a cache from a database, you will

be able to tell GSAK to ignore it in the future.

menu.

1. Open the GSAK Class database.

2.

3. Right click on the cache to open a new
4,

5. Make sure This waypoint only is chosen.
6.

Objective 4.1a: Add Old Griz to the ignore list

Single click on the Old Griz cache to highlight it. Highlighted caches are usually turquoise.
Click on the Delete waypoint... menu item to open the Delete Waypoint window.

Check the box next to Also stop future imports adding back in.

-
Delete 1 waypoint

(e

@ This waypoint only 1 All waypoints

in filter

[7] Also stop future imports adding back in

Settings

]

) User checked (") All waypoints in database

Prevent locked waypoints from being deleted

This waypoint will be deleted from the cument database. Are you sure?

[ Last active

'H i save ][ i Delete J

| | ok | | Mcace | | 2 tHen |

\

)

7. Click the OK button.

Old Griz will be removed from the database and added to the ignore list. Your database should now

have 9 caches in it. 9 Shown (all waypoints)

R=0
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i\x Keep in mind that GSAK will remember your previous settings. Since we just deleted a cache
£ and added it to the ignore list, the next time you go to delete a cache the “Also stop future
imports adding back in” box will still be checked. Don’t forget to uncheck it if you don’t want the
cache in the ignore list!

4.2 Deleting Caches from Your Ignore List

Checking to see which caches are in the ignore list, and removing them, is easy.

i Objective 45.2a: Remove Old Griz from the GSAK Ignore List

1. Click the Database menu.
Click the Maintain Ignore List... menu item to open the Ignore List window.
Check the box next to Old Griz, or if you wish to remove all caches from your ignore list, click
the Check all button.

4. Click the Delete button.

Your ignore list should no longer have Old Griz in it. You can now reimport the gsak201.gpx file and
Old Griz will be added into the database.
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5.0 Views

Views in GSAK are very handy if you like to have more than one setup for which columns to see. For

example, in your found database you may want the Found by Me column showing but not showing in

other databases since you know you haven’t found any of them. With GSAK we can set up different

views, save them, and use them any time we need without having to go and change the columns

every time we want to switch.

N o vk

Objective 5.0a: Create a View with the Found by Me column not visible

Open the GSAK Class database.

Find the Found by Me column and right click on it to open a small menu.

On the new menu, click Remove Column. This will remove the column from the current view.
It does not delete any data. It just hides the column.

Click the View menu.

Click the Save Current View... menu item to open the Save view window.

In the Save view window type Unfound in the View name box.

Click the OK button.

You will now see Unfound in the Views dropdown on the toolbar. Any time you wish to use this view

you can choose it in the dropdown and GSAK will switch to the columns you left visible in the view.

' Views
\ | Unfound v I

Objective 5.0b: Assign the view to be used every time you open the GSAK
Class database

Sometimes you may want a specific view to be used on a particular database. Instead of just using

whatever view is currently chosen, you can tell GSAK to use a specific view by default with a specific

database.

1.

o vk wnN

Open the GSAK Class database.

Click the Database menu.

Click the Properties... menu item to open the Database properties window.
If the Use defaults checkbox is checked, uncheck it.

In the Associated view dropdown choose Unfound.

Click the Apply button.

Now when you switch between databases, when you open the GSAK Class database the Unfound view

will always be shown by default. You can always change views by choosing a different one from the

dropdown but that will be temporary since Unfound is set as the default view.
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i Objective 5.0c: Delete the Unfound view
Click the Views menu.

Click the Delete a View... menu item to open the Delete a view window.
Check the box next to Unfound.

Click the Delete button.

P wNPR

Now that the view is deleted, any databases that were using it as the default view will be changed to
show the default view that is built into instead so you will want to check those databases and make
sure an appropriate view is chosen for them.
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6.0 Repair/Defrag

Databases are quirky things. They don’t always do what you think they are doing. That isn’t an issue
most of the time. However, over time, your databases can become sluggish or corrupt. There is an
easy way to fix most database issues in GSAK called Repair or Defrag (short for defragment).
Databases can become fragmented with frequent use. For example, when you delete a cache, that
record isn’t really deleted from the database. It is just marked not to show. As you delete or move
caches from a database, more and more unusable records accumulate. This causes a degradation of
performance. Other times your database may become corrupt for any number of reasons. If you have

any trouble using a database, just repair it!

i Objective 6.0a: Repair/Defrag the GSAK Class database
Open the GSAK Class database.
Click the Database menu.
3. Click the Repair/Defrag menu item to begin the process. A message box will appear giving you
a message that if the repair doesn’t fix your problem, you may have to delete it. (Remember
the backups from the 201 class!)
4. Click the Yes button if you wish to continue.

GSAK will now go through the database, clean it up and attempt to fix the corruption. Too bad we
can’t Repair/Defrag the three branches of government.
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7.0 Shortcut Keys

GSAK has many shortcut keys already assigned to functions throughout the program. However, not all

functions that you may use regularly are assigned shortcuts. You can tell if a function has a shortcut

assigned by looking in the menus. For example, if you click the Search menu, you will see Ctrl+F to the

right of Filter... and F8 to the right of User flag set. That's telling you that if you press Ctrl+F on your

keyboard it is the same thing as clicking Filter... with your mouse. And, pressing F8 on your keyboard is
the same as clicking User flag set with the mouse.

You'll notice in the screenshot that Cancel Filter do not have a shortcut key assigned. Let’s go assign

| Search | User Flags View CentrePc

Filter...
User flag set
1 Restore last filter

Cancel Filter

one now.

i

P wNPR

5.

Shortcuts shown on menus, like the above screenshot, are not unique to GSAK. Most software

Ctrl+F
F8

has shortcuts assigned and they show what those are the same way that GSAK does.

Objective 7.0a: Assign F9 as the shortcut key for cancelling a filter

Click the Tools menu.
Click the Options... menu to open the Options

window.

Click the Keyboard Shortcuts tab to see a tree view of the entire GSAK menu system.
Click the + next to Search, or just double click the word Search to expand the menu system for

the Search menu.

-~

Options

(S5

General ] HTML ] Locations ] Display ] Abbreviations  Keyboard shortcuts I Advanced ]
To add shortcut keys, drag them here. To remove, drag the menu option back over to the shortcut keys

- File

) Search

Filter...

User flag set
Restore last filter

#-User Flags
- View
#-Centre Point

[+~ Waveoint

Ctrl+F
F8

W Cancel Filter

Shortcut keys

; F10
F11
F12
Ctd+C
Ctr+l
Ctrd+S
Cid+V
Cid+X
Ctd+Y
Cri+Z
Ctrd+F1

m

In the pane on the right find F9. Drag it to the left pane and drop it onto Cancel Filter. You will
see F9 appear to the right of Cancel Filter indicating that F9 is now the shortcut for Cancel
Filter. You will also be able to see that F9 will appear to the right of Cancel Filter in the

dropdown menu in GSAK.
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8.0 Quick Filters

In this section, we will cover a couple of alternate ways to filter your database quickly. GSAK refers to
these as Quick Filters. We will also cover other ways to quickly filter although they aren’t technically
referred to by GSAK as “quick filters”.

8.1 Using Quick Filters

When you have an open database, sometimes you may want to quickly filter on some sort of
information. For example, you may want to filter on only Traditional cache types. Instead of creating a
filter and unchecking all the boxes for other cache types on the Filter window, you can simply use
Quick Filter.

I Objective 8.1a: Use quick filters to filter on Traditional caches only

1. Open the GSAK Class database.
In the column that shows the icons for the cache types, right click any of them that has a
Traditional cache icon. The menu below will appear.
I_;‘i‘x\‘ It's important to pause here and point out that you MUST right click anywhere in the
== column on which you want to filter AND not on the column header at the top of the
column. If you right click on the Waypoint Name column you will not be able to quick filter for
cache type. So, make sure, for this objective, that you right click in the Cache Type column.

3. At the bottom of the menu click Quick filter to open a sub menu.

gl R —— | 65210 N  Border Brats
Open Waypoint URL 765.96| NW | Hide'N'Seekers
Show Offline (in browser) 779.25 NW | eyeintheskytoo
Custom URL » & 91570 SW RUSTYPITON
Add to publish logs 961.12 W | RPM&HareyGid

1129.56 NW | Menmy Mocksters

Refresh 1208.59 W  Pip-Boy3000
Add... 1281.03/ NW | zac59410
Edit... 1437.05 NW | mineral2

Delete waypoint...

Delete logs...
Add/Change/Delete Note...
Corrected Coordinates...
Child waypoints...

Force elevation refresh

Cache status >
Set This Cache as Centre Point

Add to locations

Send to GPSr now

Show current row number

Project waypoint...

1 )
Color waypoint... own (all waypoints) =0

—_Show on Qzifxplorer Map | —
Quick filter 4 Add to existing
p o | Replace

/pe: Traditional | Size: Micro . I‘
ier Brats @ (Found=5002 Hidden=81, ¢
Avai| Copy to clipboard

Cauntruys Hinitad Ciafac 1

Copy to Mfilter box
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4. Inthe sub menu that opens to the right, click Replace. This option will replace any filter that
you currently have set. The menus will disappear and you should only see Traditional caches
in your list. Do not clear this filter yet. We will use it in Objective 9.1b coming up next.

Objective 8.1b: Add to our existing filter to include only caches with a

bearing of NW

1. If you did clear the filter from Objective 8.1a, go back and do it again but do not clear the
filter.
2. Right click on the Brg (Bearing) column of a cache with a bearing value of NW to open the

same menu as the previous objective.
3. Click on the Quick filter menu to open the sub menu.
4. On the sub menu click on Add to existing.

When the menus disappear, you should see only caches that are Traditional and have a NW bearing.

8.2 Filtering from the Status Bar

For the benefit of Major134, the Status Bar is the little bar of information that sits between your open
database and the pane below it with the currently highlighted cache information. It should look similar
to the screenshot below.

Subset: None 10 Shown (all waypoints) K=0 Centre point = Home Counts: 0 10 - 0

It contains 4 sections with different information in each. Starting from the left and moving right, they
are:

1. Subset. If it says None then no filter is set. If it is red and says filter, then there is a filter set.
The next section shows you how many waypoints (caches) are currently visible and how many
are marked with the user flag.

3. The third section tells you which Centre point you have selected.

4. The final section tells you how many caches in the current filter are found (yellow), unfound
(white), archived or inactive (red) and how many belong to you (green).

@ Don’t worry if your colors don’t match mine. It's simply using the colors you have set in the
" Tools > Options > General tab in the Status Attributes section.
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i Objective 8.2a: Set a filter to show only found caches

Open your GSAK Class database.
For this objective, we are going to mark a cache found. Right click on the BeeHave! cache to
open a menu.

3. Click on Cache Status to open a sub menu.

4. On the sub menu click Set to Found. The cache should show a found date and be colored
yellow (or whatever color you have set for found caches).

5. Inthe far right, section of the status bar your Counts should now be 1,9, 0 and 0. The 1
indicates that you have found one cache and the 9 is how many in the current database or
filter that you have not found.

6. On the status bar, double click on the 1. This will filter for caches that are marked found. You
should now see only the BeeHave! cache in the list.
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9.0 Custom Data

Sometimes the columns available in GSAK may not be enough for what you need, or want, to do. For
example, you may want to put the name of the city where the cache is (there is a macro that will do
this for you called GetLocations.gsk). Currently there is no column for city built into GSAK so we will

have to create it.

0 Custom column, custom field and custom data are all interchangeable terms and refer to the
same thing.

l I. Objective 9.0a: Add a custom column for the city name where the cache

is located
1. Open your GSAK Class database.
2. Click the Waypoint menu.
3. Click Custom data... to open the Edit custom data window.
4. You will see a list of custom columns that already exist, if there are any.
r 5 N
Edit custom data @
Field Value
radius 161.0
Place
PlaceType
SchoolDistrict
USGS_Quad
FilterD ata
[ ' Save ] [ Fields “ ¥ Cancel ] [ 2 Help ]

\ 'J

5. Click the Fields button to open the Update custom field names window.

7 = - »
Update custom field names . @

Type ] Scope ISequence I Control I Height I Default -

Real All databases 10 0161 | |
Place string All databases 20 standard 0 \
PlaceType string All databases 30 standard 0 ‘

SchoolDistrict string Al databases 40 Standard 0 iE 5
USGS_Quad string All databases 50 Standard 0 }
FilterD ata string Al databases 70 standard 0 |
|

|
' = '

= i

[ o Save || + Add || [GBIE it ll_@oelete ]] ¥ Cancel H 2 Help ]

U —— e = P ——— — y



http://gsak.net/board/index.php?showtopic=22382&st=0&#entry229478

Click the Add button to open the Add/edit custom field window.

' B
Add/edit custom field &J
Field Name |
Tioe —— [ Editbox
2% IStnng—v @ Standard () Large

Scope @ All Databases " Only this database

Sequence an

Default value

Sqlite expression
[Grid display only]

’ v 0K ‘ [ ¥ Cancel | [ ? Help ‘

.

6. Inthe Field Name box type City.

7. Type should be String since we will be typing normal text into this field.

8. Edit box should be Standard since we will have relatively short values. If you want to be able
to type longer values like sentences or descriptions, you can choose Large and then play with
the size of the box to show.

9. Choose Only this database for Scope. If you want the new column to be on all databases then
choose All Databases.

10. Sequence will simply determine which order it will be shown on the edit window when you
add a value to the cache. So, if you have 2 other columns and their sequences are set to 10
and 20, you could make this sequence 15 so that it will show in between the two. However,
for this objective we will leave it at whatever the default value is that is showing.

11. If you want a default value for the field, set it in the Default value box. For now, leave it blank.

12. Leave the Sqlite expression field blank. That’s for another class. ©

13. Click the OK button. The Add/edit custom field window will disappear and a row for City will
now show in the Update custom field names window.

14. On the Add/edit custom field window click the Save button to add the field to the database.
The window will disappear and the Edit custom data window will now be visible again. If you
want to add a value to City for the currently highlighted cache, you can do it here.

15. Click the Save button.

You have now added City to the list of columns available for the GSAK Class database.
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Objective 9.0b: Make the City custom field visible in the database grid

We just added a custom field but we still can’t see it in our database grid. Let’s go make it visible.

Open the GSAK Class database.

Click the View menu.

Click the Add/Remove columns... menu to open the Tools > Options window with the Display
tab already chosen for you.

On this tab you will see two sets of check boxes. The ones on the left are the standard
columns that are built into GSAK. The ones on the right are custom columns that you, or a
macro, have added to GSAK. Check the box next to City.

Click the OK button.

The City column will now be visible on the far right of your open GSAK Class database.

NouhswnNR

Objective 9.0c: Add a value to the City custom field

Open your GSAK Class database.

Highlight (left click) the BeeHave! cache.

Right click the cache to open a menu.

Click Edit... on the open menu to open the Edit Current Waypoint window.

At the bottom of the window click the Custom button to open the Edit custom data window.
Enter a value for City in the box next to City.

Click the Save button.

The value you entered is now saved in the City column for that cache.

Objective 9.0d: Delete the City custom field

So, for whatever reason, we have decided that we no longer want or need the custom field called City

that we created. Time to delete it.

el

o N WU

Open the GSAK Class database.

Click the Waypoint menu.

Click the Custom Data... menu to open the Edit custom data window.

Click the Fields button on the Edit custom data window to open the Update custom field
names window.

Left click on the City field to highlight it.

Click the Delete button.

Click the Save button on the Update custom field names window.

Click the Save button on the Edit custom data window.

The City field will now be removed from your database.
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i\ Removing a custom field will also remove all data that was contained in that field. There is no

== “back” button and no “Are you sure you want to delete?” window. Make sure you really want

to delete it before you do so. If you do delete it and didn’t want to, you can restore a previous backup
to get it back.

i\ If you remove a field whose scope was set to All Databases when you created it, it will be

£== removed from all databases, not just the one you have open at the time.
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